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4. Lighting, using camera and rendering
Sobhi Ahmed
Comp3351
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Outline

I.  Lighting Types and Settings
[I.  Cameras
III.  Rendering

e e
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ction

» The default scene in Blender contains a Cube object, a Camera

and a Lamp
Default lamp

Camera

» The lamp allows lighting the scene
» The camera sees the final output which will be render out

» An accurate setting of the light and the camera is important to
obtain an impressive result

e ot
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L.

1ght types and settings
Lamp types

» There are different kinds of lamps available to use in Blender:
- Point: Basic Blender Lamp, shines all directions

- Sun: Provides even angle of light, regardless of placement from

- Spot: Shines a direct angle of light
- Hemi: A wider light, much like area lights

- Area: Provides large area lighting, can be scal

objects

S T A ' |
) \\ 51 *
Point Sun Spot :
e Hemi Area

‘)/"L-—"uw
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1ght types and settings
1. Lamp types

~ Different ways to add any of these lights into the scene :
- Through the Lamp area in the Add menu

- Using Shift+A in the viewport then choose Add > Lamp and select
your type

A. Force Field v Armature

H Lattice

Ernpty

) Speaker

7
8- Carmera

Armature R .
Armal =, Point

Tk

& Sun
,_f Spot
Group Instance

- & FI s I__-\I |_—||:r|'|i

™
L Area

Metaball
Surface

Force Field

Curve
Mesh

L
E
F
A
*
>
\?"

& Object Mode + @ 7 &

- Better when adding a lamp: go to top view to add the lamp then to
front view to adjust height.
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1ght types and settings
2. Lamp properties

»Each of lamp type has options
that apply to it

» These options can be accessed
via the Lamp Properties panel

» There are generic options and
some specific options

»Most important generic options:
S Lignteolon.
e Energy (Brightness
o Distance (how far the light shines)

» Shadow
» Adding texture to the lamp

»Sun and Spot lamps give some Lol —
different options. Constare amc

Preview window

Lamp type

General settings

Shadow options

oo oy
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1ght types and settings
2. point Light

»Options:
e Light color
e Energy (Brightness)
o Falloff Distance
e Negative
* Sphere
» Shadow:
* hardness

»Adding texture totke lamp
e With lamp selected add atexture.

Constant QMC

e
TFEFUMENTS-HUB.com
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1ght types and settings
2. point Light

» Sphere : will light just inside the
sphere area (sphere area depends on
the distance value).

» This layer only: limits the effects of
the light to the objects exist in the
same layer as the lamp.

»Negative: reverses the illumination
power of the lamp, emits darkness
instead of light.

~Shadow : Rayshadow selected

»Sampling: the method how the
shadows are calculated: hardness: = -
soften the shadow. Samples - Consant o

STUDENTS-HUB.com http://www.sage.ps - Serious Games Pathway within the Undergraduate IT Programsu ploaded By 121haneen 8



1ght types and settings
3. Spotlight properties

Shadow type

» Spotlight allows creating great
effects

> It can be scaled, rotated and
positioned to cast shadow as the
other lamp types

Shadow color

Buffer type

Irregular Deep

Filter & sample

»It can be used with halo s
eff?CTs: giving a simulation of a light [F&= 1000, -
shining through a fog

Spot shape

SFUMENTS-HUB.com ploaded By: 121haneen
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1ght types and settings
3. Spotlight properties

~ Spot Shape: Set the Angle Size,
Blend (edge softness- With low
amounts of spot blend, the circle of
light cast by a spotlight has sharply
defined edges. As the blend is
increased, the edges of the circle
fade.), and Shape (round or
square). You can also give it a haze
with the Halo settings and
intensity. J &

Irregular

e
TFEFUMENTS-HUB.com
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B
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Shadow type

Shadow color

Buffer type

Filter & sample

Clip start & end

Spot shape

ploaded By: 121haneen
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1ght types and settings
3. Spotlight properties

Changing the spot size

Adding spot blend

7257 s

TFUOENT

ploaded By: 121haneen .
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1ght types and settings
3. Spotlight properties

» Raytraced shadows :

» provide more physically accurate
results, but can be slow to render.

» Buffer shadows :

e quicker to render, but less accurate

e Has Clip Start and Clip End: Gives a
range for calculating shadows

Classical

e
TFEFUMENTS-HUB.com
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Shadow type

Shadow color

Buffer type

Irregular Deep

Filter & sample

1

Clip start & end

Spot shape

ploaded By: 121haneen
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1ght types and settings
3. Spotlight properties

Different Soft Size values applied in the shadow settings of a

spotlight I

Different amounts of shadow samples with the same soft size

o

Ein_—rmale
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ctivity

Activity 4.1 Title: Test Spotlight effects

Type: Individual activity — Lab exercise

Goal: Familiarize students with Spot lamp effects ILO P1

Outline: Students should experiment the Spotlight effects, by following these steps:

e Place a monkey and a plan objects in the viewport as shown in Figure 1
e Add a Spot Lamp to the scene and set it as shown in Figure 2

e Vary the following parameters:
— Light color
— Energy
— Distance
— Spot size (in the shadow settings)
— Spot size by adding spot blind (in the shadow settings)
— Soft size (in the shadow settings)
— Shadow samples (in the shadow settings)
— Buffer type
e Student should prepare a brief synthesis containing different

screenshots of different tests

One course session

Assess the synthesis prepared by each student

Hffp; 7www.sage.ps — Serious Games PaEHway within the Unaergraauafe T Programs l 5 3
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ctivity

Figure 1 Figure 2

e

DN e
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ohttypes and
Sun Lamp

L

e 1.

~Sun lamps emit light in a given direction. Their position is not
taken into account; they are always located outside of the scene,
infinitely far away, and will not result in any distance falloff

Sky & Atmosphere

Point Spo Hemi

Sun & Sky Presets

" Atmosphere

o
S“FUED’EN’I’S HUB.com
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Sky :
e This button enables the sky settings: it will create a “sky”, with a “sun” if visible, and mix it with the
background as defined in World settings.

e Turbidity This is a general parameter that affects sun view, sky and atmosphere; it is an atmosphere
parameter where low values describe clear sky, and high values shows more foggy sky. In
general, low values give a clear, deep blue sky, with “little” sun; high values give a more reddish sky, with
a big halo around the sun. it can modify the “intensity” of the sun lighting.

» Here are its specific controls:
« Blending will be used to blend the sky and sun with the background defined in the World settings.
Factor Controls how much the sky and sun effect is applied to the World background.

Color space These buttons allows you to select which color space the effect uses, with the following
choices: CIE, REC709, SMPTE

Exposure : This number button allows you to modify the exposure of the rendered Sky and Sun.

Horizon Brightness Controls brightness of colors at the horizon. Its value should be in the range (0.0 to
10.0); values near zero means no horizontal brightness, and large values for this parameter increase horizon
brightness. Spread Controls spread of light at the horizon. Its value should be in the range (0.0 to 10.0);
values low in the range result in less spread of light at horizon, and values high in the range result in
horizon light spread in through all the sky.

Sun Brightness Controls the sun brightness. Its value should be in the range (0.0 to 10.0); with low values
the sky has no sun and with high values the sky only has sun.

Size Controls the size of sun. Its values should be in the range (0.0 to 10.0), but note that low values result
in large sun size, and high values result in small sun size. Note that the overall brightness of the sun
remains constant (set by Brightness), so the larger the sun (the smaller Size), the more it “vanishes” in the
sky, and vice versa.

% L;gg‘g IFIEfB 'Back Scatter Light”, result on sun’s color, high values result in more 1@16]% gggg%‘i}?el%irhaneen
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e This button enables the atmosphere settings. It will not modify the background,
but it tries to simulate the effects of an atmosphere: scattering of the sunlight in
the atmosphere, its attenuation,

e Intensity Sun Sets sun intensity. Its values are in range (0.0 to 10.0). High values
result in bluer light on far objects.

e Distance: to convert Blender units into an understandable unit for atmosphere
effect, it starts from o and high values result in more yellow light in the scene.

e Scattering Inscattering This factor can be used to decrease the effect of light
inscattered into atmosphere between the camera and objects in the scene. This
value should be 1.0 but can be changed to create some nice, but not realistic,
images.

e Extinction This factor can be use to decrease the effect of extinction light from
objects in the scene. Like Inscattering factor, this parameter should be 1.0 but
you can change it; low values result in less light extinction. Its value is in the
range (0.0 to 1.0).

e ot
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With sun right overhead (mid-day). With sun deep “under the Earth” (midnight).
Sun slightly above the horizon (start of twilight). Sun slightly below the horizon (end of twilight).
ﬁ@

SEFOMENTS-HUB.comVariations in Sun orientation, Sun Size to 5.0, all other settingsdadéf®ift.121haneen
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P Lighttypes and

Fod=t
1. Sun Lamp

» Simulates various properties of real sky and atmosphere

»When the Sun is high, the sky is blue (and the horizon, somewhat
whitish). When the Sun is near the horizon, the sky is dark
blue/purple, and the horizon turns orange.

» Sun light source; the position of the lamp has no importance, its
rotation is crucial: it determines which hour it is.

S’*UD’ENTS HUB.com http://www.sage.ps - Serious Games Pathway within the Undergraduate IT Programs ploaded By 121haneen
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Fod:t
1. Sun Lamp

» Two important angles :

» The "incidence” angle (between the light direction and the X-Y plane), which
determines the "hour” of the day (as you might expect, the default rotation -
straight down - is "mid-day”, a light pointing straight up is "midnight”, and so
on...).

» The rotation around the Z axis determines the position of the sun around the
camera.

- Note : to have a good idea of where the sun is in your world, relative to the
camera in your 3D View, you should always try to have the dashed “light
line” of the lamp crossing the center of the camera

e ot
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1. Sun Lamp

To see the sun in the rendered scene the light should be rotated
(pointing) towards the camera plane.

Rotating the sun around the z axis will move the light on the camera
plan

Changing x axis (in rot) will move the sun up and down
Better begins bY rotation camera o on z. go right view, manipulate the
rotation of the light beginning from o o o rotation

Activity:
»You can add and extrude a plane
e Exp: at pos (000) and rot (000) s (3 4 0.1)

» Better when adding a lamp: go to top view add the lamp then to front view
to adjust height.

» Adjust the camera so that it faces the scene and the sky (front ortho)
e exp: pos (0 -50.6), Rot (9o 0 0)

» Adjust the sun so that it is below the plane and rotated to the cam
e Exp: Pos (0.8 0.1 - 0.6), Rot (-90 0 0)

» Check sky and atmosphere
e Change ssize to 4, brightness to 2 and can reduce back

& Try other options: Change size to 10

DS Y|t
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Apply different lights to the scene

» Lighting consists of a key light, which is the main light source, and as
needed fill lights to add ambiance to otherwise unlit areas.

> Different lights can be used together to get different effects

»Purpose: use key light (principal light source) and then fill lights
as heeded

»Decide carefully the location of the key light taking into account
these considerations:
» The key light is the strongest light source in the scene

» The key light should be strategically positioned so as to define the form of the
objects in a scene.

e The key light is the main light for casting shadows

e ot
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acking lights to objects

» Tracking lights to objects:
o It Allows light to track to the main object in the scene

e It's applied as follows:
« RMB-select the light
- Shift-RMB-select the object
« Press Ctrl+T and choose Track To Constraint from the menu

Damped Track Constraint

Lock Track Constraint

» The light will always point to the object
e The light can point to an empty target (using an empty object)

UDENTS-HUB.com ploaded By: 121haneen
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irect lighting

- Indirect lighting: It is the ability fo make objects emit their own
light

- To make objects emit their own light, follow these steps:
» Select the object and set up its material with the Emit feature on

Default cube
selected

e

SFUMENTS-HUB.com loaded By: 121haneen
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Indirect lighting

e In the world settings, set the Horizon and Zenith
colors to black

 In the world settings, find the panel labeled Gather and
turn on Approximate

 Check and open the panel named Indirect Lighting

e Set the Factor slider and Bounces which controls the
light effects (how many times the light bounces)

Raytrace
4 Error: 0.250 ¢

ploaded By: 121haneen i
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ctivity

- Activity 4.2: Experiment light settings (30 min)

- Using a monkey and a plan objects, as shown in Figure 1 (activity 4.1),
test the following settings:

- Apply different lights to the scene
- Use many lights fogether
- Use tracking lights to objects

- Add a cube to the scene, nearby to the monkey, and apply the
indirect lighting effect to this cube

- Give screenshots for each setting

e
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~ Cameras

The camera is the our eye into the scene- is what we see
finally when rendering.

»Fixing Up the Camera View
»Lining up the Camera
»Tracking to an Object
»Tracking to an Empty Target

»Multiple Cameras

i
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ameras

Lining up the Camera
» Techniques for aiming the camera at a given object:

e navigate in the 3D view to the point of view you would like the
camera to have, and then press Ctrl+Alt+numpad o

e use fly mode by pressing Shift+F with the mouse over the 3D view,
Click the LMB causes the view to hallt.

e e
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~ Cameras

Split the view

» In reality, lining up the camera can be deceptively difficult.
Fortunately, there are some techniques for aiming the camera at a
given object:

e Navigate in the 3D view to the point of view you would like the
camera to have, and then press Ctrl+Alt+numpad o, which

causes the camera to jump to where your view is taken from, and
look into the scene from your point of view.

e Use fly mode by pressing Shift+F with the mouse over the 3D
view. In this mode, the view pivots around to follow your
mouse pointer. Using the W and S keys or rolling the MMB
causes the view to accelerate in and out of the scene. Clicking
the LMB causes the view to halt, whereas clicking the RMB
resets the view to the starting position. Using this technique
from the camera view moves the camera.

e ot
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Cameras
1. Camera settings
» The scene contain one camera by default

» The black triangle mark the square face of the camera and
represent which way is up

~ It is possible to use many cameras
» To add new camera, use "Shift+A"

»To change the active camera, select that camera and press
“Ctrl+Numpad 0"

» The camera is manipulated like any other object
~Resolution in render manipulate the size of camera view area

1) Speaker

'Ei. Larmp
Add a camera object to the scene

y L.. Force Fielc

A Group Instance

Soh e The camera Shfit+A
S’*UD’ENTS HUB.com http://www.sage.ps - Serious Games Pathway within the Undergraduate IT Programs ploaded By 121haneen
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. Cameras

~Like all other objects, the camera has settings:

Camera button
Camera view types

Orthographic Panoramic

Millirmeters

Carnera Presets

Depth of Field

Composition Guides ¥

Display options

v passepartout

e e
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~ Cameras

» Like all other objects, the camera has settings:

» Perspective/Orthographic: Used to set the camera from showing a true-life
perspective view to an orthographic view.

» Lens (Focal): Set-up a lens length much like a real camera. 35mm is a good, safe
setting, but wide and tight angle setting work for different needs. Zoom.

» Panoramic: Changes camera view to reflect a cylindrical camera.
» Shift: Pushes the view left, right, up, down from actual camera view, without
changing perspective.

> Cli})]l))ing: Start and End- How close and how far an object can get to the camera and
?til e seen. In very large scenes, this needs to be set higher or things “disappear”
rom view.

» DOF- (Depth-of-field): Used with nodes to blur foreground and background objects.
» Limits: Draws a line in the scene to help you visualize the camera’s range.

» Size: How big to draw the camera on the screen. You can also control size with
scale.

» Show Mist: Used to give you a visual display of how far the camera sees if using Mist
» Safe Area: Displays the inner dashed box to help with placement of objects and text

» Name: With all objects, the name of the object or camera can be displayed on the
screen, but this will display the name in the camera view.

» Passepartout: Shades the area on the screen outside of the camera’s view. You can

_.# control the darkness of the shaded area with the Alpha slider.
e i
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cras

Tracking an object

» Make the camera automatically face the target object.

»To track an object, follow these steps:
e RMB-select the camera

o Shift-RMB-select the target object so that both the camera and the model are
selected

o Press Ctrl+T
» Choose Track To Constraint on the menu that appears

»Remove Track : by Alt T or on Constraints panel remove track to constraint.

e

()
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cras
Tracking an empty object

»In the case of animation, the camera should not follow the target
object around

» The solution is to frack an empty target
> This target will control where the camera should be pointed

» This procedure is realized as follows:

e Insert an empty info the scene by pressing Shift+A and then selecting Add >
Empty

 RMB-select first the camera, and then Shift-RMB-select the empty

e Press Ctrl+T and choose Track To Constraint

- The camera will always look toward the empty, Simply place the
empty where you need the camera to look.

SEENTS-HUB.com
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Solution

» The default camera gives a limited view of meshes (perspective
distortion)

»In order to decrease this distortion, follow these steps:
e Select the camera and go to the Object Data tab

e Go down to the Lens section, and change the Focal length from 35 to a greater
value : The scene as viewed through the camera will appear to jump to a bigger
size.

- Tt is also useful to enable the "Passepartout” option in the
Dlsplay panel in order to make the model very clear

— ) = = =
L 4 —"-l
5P
[l E =
g5 Camers
Orthographic Panoramic
[ Focal Lengt: 35.00 3 IS ;

- ey - .
0.000 L3 0.100
W -y . T
0000 = OO, 000
BTV
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Multiple Cameras

»You can add multiple cameras to the scene

»Set the active camera by selecting the camera then go to view-
cameras- set active object as camera (Ctrl + NumpadO).

» Align camera to view : Go to view- adjust the 3d view then go to
view - align view- align active camera to view (ctrl+Alt+numpadO).

Reposition the camera by LMB in camera view, or by Shift+F

oo oy
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ctivity

>A<;'r)ivi1y 4.3: Experiment camera tracking and fixing up settings (15
min
- Using a primitive mesh, test the following camera operations :
« Tracking fto an object
- Tracking to an empty target
« Fixing up the view
- Give screenshots for each operation

oo oy
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. Rendering

» What you want as an output from your
scene

» The render window gives you the
output of the scene

Image Editor

» The render settings panel is located
in the properties panel and it is
displayed by default

» The render settings panel contains
the specifications of the output of
the scene (format, resolution, size,...) 5 [ 21 16 || micheletravai &

e
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. Rendering

»Render/Animation/Audio Buttons:

~ Display: if your render occurs in a viewport or in a
hew window

> Dimensions:

» Resolution-size (Manual input of x and y values for
rendering size instead of using presets.),

e frame range: Set the start and end frame for
each rendering and the number of steps.

e scaling and Aspect ratio : Setting the size of the render
display in the 3D window
o fr'ame rate. Anlmaflon p'QYbaCk rate. 5 11 16 | Mitchell-Netravali 4

 If you make an animation and it runs too fast or
slow, you can change the mapping and scale the
time with Old Map and New Map.

» Anti-Aliasing: Output quality settings. Samples with
smooth the edges of objects. Default is 8.

STFUDENTS-HUB.com
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. Rendering

» Shading: Settings that can be turned off to exclude
features from the render;

* the "Alpha Sky" drop down menu gives options for the render
background.

> Output: Set file types for outputs and saving
locations. You can also set compression quality for
images. It's always a good idea to type the file
extensions when naming output files. For movies,
there will be encoding options in a panel.

»Performance: Settings for render performance.
» Stamp: Labeling for frames and movies if needed. s [l 11 16 || mitchelNetraval §

» Bake: Baking is a feature where certain processes
can be saved to speed rendering.

» Frame rate. Animation playback rate (25 FPS for PAL
output, 30 FPS for NTSC output).

Image Editor

STUDENTS-HUB.com http://www.sage.ps - Serious Games Pathway within the Undergraduate IT Programsu ploaded By 121haneen 41



. Rendering

~Render Layers: Control which layers or groups to render.

~ allow you to render your scene in separate layers,
usuallz| with the intension of compositing them back
together afterwards.

» The Layer Panel shows many settings:

e Scene: The Scene Layers, showing which are currently
visible and will be rendered.

 Layer: The Scene Layers which are associated with
the active Render Layer.

e Mask Layer: Objects on these will mask out other
objects appearing behind them.

e Material: Overrides all material settings to use the
Material chosen here.

e Light: Enter the name of a light group, and the scene
will be lit with only those lights.

e Include Options: Each render layer has its own set of Visoid ¥ sk
features which can be enabled/disabled to save time v Walo ¥ Edge
and give you control when working with passes s ) Srand

===

oo oy
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Render a simple image

»In order to render a simple image, follow
these steps:

 Choice the Render button in the Render panel or Press
the "F12" button. _p—

* Choice a high resolution to obtain a high quality image

» Set all of the remaining rendering settings (previously
discussed) especially the output settings

 Press "F3" button to open the file save window and give
your file a hame and set the location

Blender Render v Dverwrite " File Extensions

8z
= PG

[ Documents_These
[ Programmes
[ technologue
[ temiporaire
untitled.png 24 KiB
oo [
TFUDENTS-HUB.com
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Render a movie file

»Rendering a movie x=—)You have a scene with
animation

»Here are the steps to create a movie file:

 In the Dimensions tab, select the encoding format and
check the output resolution

e Check that the 'Start' and 'End’ frames of the animation
are selected and check the frames per second setting

* Make sure 'Anti-Aliasing’ is ticked and that 8 is seleetet

e In the Shading tab make sure Shadow and ray tracing are
ticked

e In the Output tab select the file format from the format
selection dropdown menu (try AVI)

e click the file folder button and set your location and name
of the movie file.

 If you want, set the additional options in Performance, post
Processing, Encoding and Stamp tabs

e Finally, press the 'Animation’ button in the render tab
et
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Render a movie file

»Rendering a movie =—)You have a scene with
animation

»The movie may take a while to compile
(minutes, hours, days depending on
complexity and computer speed) since it
needs to render each and every frame of the
movie.

= mPEG
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ctivity

» Activity 4.4: Experiment rendering types (30 min)
« Which are the possible rendering types in Blender?
- Explain each type of rendering and test its settings

- Give example for each rendering type

e
TFEFUMENTS-HUB.com

ploaded By: 121haneen .

http://www.sage.ps - Serious Games Pathway within the Undergraduate IT Programsu



m

13
& 59

Activity 4.5 Title: Use lighting and world settings

Type: Individual activity — Home work

Goal: Discover some lighting and world settings ILO P1

Outline: A student should use four cubes, a monkey object, Blender lighting and
world settings to create a rendered image that looks something like this
image.
One class session

Timeline

Assess the final work of each student and his contributions,
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Thank you for your attention!
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